
Advice for Quality Presentations 
 

Resource:  
1. North Carolina State Library Toolkit: 

http://www.lib.ncsu.edu/toolkits/presentations/good_speaking.html  
2. The Kaneb Center for Teaching and Learning, University of Notre 

Dame 
 

Strive for Five C's of Presentation Excellence: Look & sound:  

• Confident,  
• Credible,  
• Competent,  
• Convincing, and  
• Comfortable.  

 
The Basics 
 Be conservative. 
 Be simple. 
 Be conventional. 
 Plan for at least 1 minute per slide.  1 ½ minutes is better. 
 Have slides read from left to right; from top to bottom. 
 People see graphics first, then text. 
 A logical flow of information is essential. 
 If a long presentation, then summary slides are appropriate. 
 
Additional Design tips:  Remember goal involves improving retention. 

1. Use sufficient white space. 
2. Use contrast (dark-on-light or light-on-dark) 
3. Design from top left to bottom right 
4. Use large font size (minimum 18/24 points) 
5. Limit use of bold, italics or underlining 
6. Do not write in all UPPERCASE 
7. No more than two fonts on a screen (preferably one) 
8. Be concise with text 
9. One main concept per slide 
10. Background patterns make slides harder to read 
11. When creating original images, use high quality equipment 
12. Edit files to reasonable size 

 



Principles of Good Speaking and PowerPoint: 

In most cases, the PowerPoint show is there to enhance your presentation – and 
not to substitute for it.  Despite the presence of the media, principles of good 
speaking also apply to presentations that incorporate PowerPoint. 

 Focus on the Content:  As the saying goes, “The main thing is to keep 
the main thing the main thing.”  Don’t let use of the media hinder you in 
addressing your topic. 

 Don’t Read from the Screen:  Overly relying on the presence of the text 
is by far the most common problem with novice PowerPoint users.  Your 
audience can, and should enabled to, read for themselves.  

 Maintain Eye Contact with your Audience:  It’s very easy to be 
distracted by the content on your screen.  A minor exception to this 
guideline is a need to draw your audience’s attention to a specific part of 
your slide.  For example, you could use a pointer to identify a trend of a 
graph. -- Otherwise, there's simply no reason to show your back. 

 Don’t Limit your Presentation to the Screen: Reading from the screen 
prevents you from elaborating beyond what they see.  Consider providing 
additional information and clarifying your comments.  

 Keep Pace with Yourself:  At first, you may find it difficult to coordinate 
speaking and showing your slides simultaneously.  However, coordination 
of the two is essential in preventing confusion.  Some practice could be 
required to prevent getting ahead of yourself.  You may find it helpful to 
make notes to yourself of when you need to advance slides. Doing so 
minimizes the need to look at the screen itself.  

 

Customization: Templates and Master Slides:  

 Templates:  Templates enable you to customize the format of your 
presentations.  If you would like to create a presentation in which all 
slides show the Old Well on a background of Carolina blue, you can design 
a template which can be applied to your slides.  

 Master Slides: Similar to templates, the Master slide allows you to 
establish a consistent formatting.  For example, by using the Master Slide, 
you can place text that uses a specific font in the same position on every 
slide.  

Return to Top  

 



Prevent Distraction: Minimize Bells and Whistles!  

Your priority should be to create a PowerPoint presentation with substantive 
content rather than a hyperactive show.  The overuse of eye-catching features is 
distracting and could even be annoying. Don't be embarrassed by content-filled 
slides without fancy multimedia. -- A good motto:  “Don’t do it just because you 
know how to!” 

 Powerful Graphics: Because PowerPoint is visual media, graphics can 
greatly enhance your presentation.   PowerPoint is ideal for providing 
diagrams and conceptual representations that help illustrate your ideas.  
Note, however, that the overuse of large images reduces your amount of 
usable screen space, so consider limiting their use.   

 Appropriate Graphics: Are specific images even necessary? Although 
Microsoft presents many convenient Clipart categories [Office, Travel], 
these stock images could be inappropriate and irrelevant to your content.  

 Original Graphics: Hand in hand with the importance of powerful and 
appropriate imagery is the use of original graphics.  Anyone who has seen 
lots of PowerPoint presentations will recognize the familiar clipart and 
templates which come with the program. Many clipart sites exist on the 
Web, and the majority of these sites are free.   

 Consistent Transitions:  Transitions, those effects that introduce slides, 
should be consistent throughout your presentation.  In PowerPoint, you 
can assign transitions globally (same for all slides) or individually 
(transitions vary).  A common mistake among novice PowerPoint users is 
the incorporation of too many different transitions. Definitely ignore the 
"random" transition option. 

 All Build Effects are not equal:  Like transitions introduce entire slides, 
build effects are those means with which bulleted text or graphic objects 
are introduced within a slide.  For example, you may choose to have your 
points “Fly from the right” side.  Selections are generally a matter of 
preference; however, some build effects could divert your audience’s 
attention.  “Swivel,” for example, may produce an interesting entrance, 
but watching the spinning effect takes infinitely more time than reading 
the text.  

 Minimal Animation:  Used sparingly, animation lends a dramatic 
element to a presentation.  Unfortunately, many new PowerPoint users 
are far too liberal in the use of animation.  

 Sounds:  Sound should be used in moderation – if at all.  Remember, 
cash registers and screeching brakes could demand more attention than is 
appropriate.  

 



Planning your Presentation: Communicate Clearly. 

The power of public speaking rests in both effective organization and clarity. 
These elements are also essential when creating PowerPoint presentations. 

 Remain succinct:  PowerPoint inherently is a device for communicating 
concisely. Be direct with your content. Writing 20 word paragraphs on a 
slide defeats your objective. 

 Don’t overload:  Packing too much content in a single slide could be 
confusing.  Consider increasing the number of slides.   

 Make your slides count:  Is the slide necessary?  If not, omit it or 
combine it with another slide.  

 Maintain depth: Due to the nature of the media, it’s easy to resort to 
citing facts.  However, are you also providing interpretation?  Let 
PowerPoint assist you in conveying complex ideas to your audience.  

Tip: To keep an appropriate pace, aim for showing about 1-2 slides 
per minute.  

 

 

Mark your Trail: Providing Directions. 

PowerPoint authors should consider several options that could add context to the 
audience.  

 Announce your Objectives:  Especially for longer presentations, your 
audience will benefit from knowing what your presentation will be about.  
Providing an approximate table of contents will assist them.  The “Agenda 
Slide” feature of PowerPoint may be of use to you here. 

 Decide ahead of time whether slides are for simplification or 
elaboration:  Consider the role of the slide. Should you tend towards 
detail, or is additional information best saved for later slide? 

 Develop a consistent title convention:  To assist your audience in 
recognizing what the overall topic is, you can provide context via a 
descriptive title on the individual slides.  For example, preface all slides 
that address a certain topic with a “Topic: Subtopic” title. 

 Take advantage of the footers option:  Footers enable you to annotate 
at the bottom of slides, placing your name, your presentation name, date, 
or customized text for your audience. 



 Frequent Summary: Every so often, assist your audience in their efforts 
to recognize the overall picture.  Don’t let the trees occlude the forest.  
PowerPoint’s “Summary slide” feature may be helpful for this. 

 

Design Tips: Easy on the Eyes! 

PowerPoint presentations should be easily readable.  Although certain formatting 
may look appealing at first, you should consider several issues before completing 
your presentation. 

 Font Size: Font Size 24 point or larger ensures that those in the back of 
the room can easily read the text.  If you require a smaller size to 
accommodate the amount of text, consider writing fewer words. 

 Light Colored Templates:  Many people find that reading dark text on a 
light background is easier to read than light text on a dark background.  
For example, the lighter templates of “Blends” and “Dad’s Tie” could be 
better choices than the darker templates of “Marble” and “Fireball.” 

 Contrast in Font Color:  Within whichever template you use or 
customize, ensure that you provide an adequate contrast in color.  On a 
yellow background, dark blue font is much more readable than a white 
font. 

 Font Selection:  Although MS Office offers a wide variety of font types, 
some fonts cause far more eye strain than others. The familiar Arial font 
is a “sans serif” font, meaning that it has minimal edges to the letters.  

Conversely, the more exotic Corsiva is a “serif” font that some could 
find harder to read. 

 

Beyond Delivery: Two more uses of PowerPoint: 

 Handouts: Speaker Notes for the Audience:  Consider using the Speaker 
Notes view to create annotated screenshots of the slides from your 
presentation.  As such, you can provide comments and clarifications for 
individual slides. 

 PowerPoint on the Web:  PowerPoint enables you to easily convert your 
slide presentations into a Web based presentations.  The program itself is 
not required to view presentations on the Web. 



Poster Presentations 

• Title, Author and Institutional Affiliation across the top of the poster 
(use a large, bold font)  

• Abstract (200 words maximum): The abstract is a concise summary of 
the presented research. It should set the stage for your presentation and 
include the following sections: 1) What is the Problem (relevance of the 
research), 2) What was done to solve the problem, 3) What was the 
outcome. Abstracts should never include a cited reference.  

• Introduction and Methods: These two areas should be kept short to 
save room for results and discussion.  Showing your methods visually is 
often a good strategy. 

• Results: The Results are the most important section of the poster. Clearly 
designed graphs and tables are critical. Captions should be self 
explanatory and informative.  

• Discussion: The Discussion explains why the results are significant and 
interesting. Include figure/table references when discussing findings. 
Arrows can be used to refer reader to the appropriate figure.  

• Acknowledgments: The acknowledgments section is one short 
paragraph thanking others for assistance and listing funding sources.  

• Additional Hints: Design your poster to have eye catching areas that 
draw the reader to important information. Font should never be smaller 
than 18 point.  

Mechanics of PowerPoint: 

Edited from website: 
http://meeting.asbcnet.org/callpapers/Powerpoint_posters.cfm 

Also see: 

http://www.kcl.ac.uk/depsta/iss/schools/writing/posters.html 

WHY POWERPOINT? 

Although there are many software programs that will create posters, PowerPoint 
is an excellent choice because it is readily accessible, compatible with most word 
processing and spreadsheet programs, and 
quite powerful, yet user friendly. 

SETUP - Creating a new poster 



1. When PowerPoint first opens, select Blank Presentation.  

2. Select the blank layout (lower right option).  Because you will create your 
own background texture and color, and will insert your own title, text, and 
graphics, a template is not necessary. 

SETTING THE POSTER SIZE 

Important note: use 
the page setup 
measurements given 
below!  

1. Under the File 
menu, choose 
Page Setup.  

2. In the Slides sized 
for box, select 
Custom.  

3. Change the 
orientation to 
landscape   

4. Type in the width 
and height of the 
poster (usually in inches, although some default to cm). Posters for 
printing at Southwestern have two options: 

1. Variable width but 36” in Height – this is a smaller poster version 
and can only be printed on “regular” paper 

2. Variable width but 42” in Height – this is the preferred size b/c you 
can use the high quality paper.  In the past, 4 ft long (48 inches) 
has been sufficient   

SETUP YOUR POSTER WORKSPACE 

This might be a good time to select appropriate 
formatting toolbars. Recommended are the 
standard, formatting, drawing toolbars. The 
picture toolbar may come in handy later for 
making refinements to graphics. The toolbars 
can be selected from the View menu. 



USING GRIDS, GUIDES 

Turn on guides 
Guides are useful for aligning images and text within a slide. To view guides, 
click on the View menu and click on Guides. 

Add or delete a guide 
To add a guide, hold down the CTRL key and drag an existing guide. To delete a 
guide, drag it off the side. Tip: To hide the guides without deleting them, click 
Guides on the View menu, Temporarily Turn off Guides and Grid. To temporarily 
override settings for the grids and guides, press ALT as you drag or draw an 
object. 

Align objects on a grid 
By default, any time you draw, resize, or move a shape or other object, it will 
position or "snap" to the lines in an invisible grid. This grid of evenly spaced lines 
helps align objects more precisely. 

You can also align or "snap" objects to other shapes so that the new objects will 
align themselves with the pre-existing shapes. For example, if you want to stack 
shapes neatly on top of each other, or have lines meet the edge of another 
shape, you can turn on the Snap to Shape option. 

On the Drawing toolbar, click Draw and then point to Snap. To automatically 
align objects on a grid, point to Grid and check to see that it is selected (it will 
look "pushed in"). 

To automatically align objects with grid lines that go through the vertical and 
horizontal edges of other shapes, click To Shape. 

HOLD IT! 

SAVING YOUR POSTER 

1. Save your poster soon and often!!! To save your poster go to the File 
menu, click SAVE and save the poster in a folder located somewhere that 
you can easily remember. Give your file a name that is readily 
recognizable….i.e.. apsposter_yourname.ppt.  

2. To set PowerPoint to save automatically, go to the Tool menu and choose 
Options. Click Allow Fast Saves, which will allow the latest changes to be 
added to your program when you save, rather than resaving the entire 
program each time you save. Also click the Save AutoRecover info. Set 
the minutes for 10-15 minutes. Should your computer hang up or should 
the power go off, the next time you open PowerPoint, your poster will 
reappear as it was the last time it was auto-saved.  



BACKGROUND 

PowerPoint has many options for backgrounds. Choose carefully... the 
background should not detract from the poster content. The colors should 
be soft, and if textured, should be selected to enhance the content of the poster. 

1. To place a background on your poster, go to the Format menu and select 
Background. The Background menu will appear on your screen. From the 
drop-down menu bar, you may select a color fill or select from the Fill 
Effects.  

2. The Fill Effects offers 4 folders: Gradient, Texture, Pattern, and Picture.  

3. The Gradient folder allows you to choose one, two, or a preset 
arrangement of colors. As mentioned above, you will want to be careful to 
choose colors which are compatible and colors which are "light to lighter" 
or "dark to darker". The "light to dark" option is not usually a background 
that is easy to work with.  

4. The Texture folder is often the background of choice, with lighter earthy 
colors being most popular. Twenty-four textures are provided with PP. 

5. The Picture folder converts a picture into a background.  You do not 
want to use the background option to insert a picture.  Instead – insert it 
into the Master Slide – View – Master - Slide 

1. Pictures can be a good or bad idea…they are hard to discern, 
they can seem to clutter the poster, and can provide an uneven 
light/dark image to place text and graphics upon. ALSO SOME 
SUBDISCIPLINES TRADITIONALLY DO NOT USE THE 
PICTURE AS BACKGROUND OPTION.  If you choose a picture, 
you will need a large file to get good resolution. Scan the image to 
the size of the poster at 150 pixels per inch or more.  

TIP:  
When using a picture background, create your poster FIRST, then 
insert the background. The large size of the picture will create 
lengthy delays when your poster refreshes each time an action is 
done. Note: A picture background will slow down the printing 
time for the poster considerably. 

 



TEXT 

Inserting text within PowerPoint 

Insert Text Box from the Insert menu or click the Text Box Tool from the 
Drawing toolbar (as show in the figure below), then click where you want the 
text box to appear in your poster workspace. You will be able to move the text 
box at any time. 

 

• Titles and headings are best when using a sans serif bold font such as 
Helvetica or Arial; serif fonts such as Times New Roman or Garamond are 
better suited for body text.  

Recommended font styles 

Arial 
Verdana 
Times or Times New Roman 
Garamond 
Georgia 
Symbols, math - Use only the most basic symbols. 

Suggested font sizes: 

• Title - sans serif, 48 to 60 to 72 pts  

• Subtitles - 36 pt, sans serif  

• Section Titles - 24 pt, sans serif  

• Main Text - serif font, no smaller than 18  

• Avoid shadow, emboss, engrave or underline formats for text  

• Keep text horizontal  

• Use several columns  

• Use lines or reasonable gutter spaces between columns  



 

TIPS:  

• Use separate text boxes for different sections on a poster. 
It will be easier to move sections around and to size text 
boxes according to available space.  

• Turn off the Snap-to-Grid feature once text boxes are 
aligned properly. This allows finer movement of graphics 
and other items.  

• Ensure all the text boxes and graphics stay within the 
page. 

Changing the color of text: 

Select the text you want to make a different color. Click the right mouse button 
and select Font and click a font color in the font box. To apply the color most 
recently applied to text, click Font Color in the Drawing toolbar at the bottom of 
the page. To apply a different color, click the arrow on the right of the Font Color 
button, select the color you want, and then click the button. 

Inserting Text from Another Program 

Rather than cutting or pasting text from a 
different application, using the following 
steps will give you more flexibility and 
freedom. 

1. Select the text in another program 
and copy (Ctrl +C).  

2. In PowerPoint, go to the Edit menu 
and select Paste Special. Choose 
Formatted Text. Click "OK"..  

3. The text will enter as a text box.  



Viewing text to see what it will look like in 
your final poster. 
The upper right hand corner of your 
PowerPoint screen has a "zoom" feature. It 
is best to work with your poster in the "fit" 
mode, but when you wish to see proper 
sizing, select 100%. What you see on the 
screen will be what will print out. 

 

FIGURES –  

Best to insert as Individual PowerPoint slide saved as a JPG or Windows 
Enhanced Megafile. – see demo 

TABLES 

You can use Microsoft Word, Microsoft Excel, or Microsoft Access to create a 
table. Microsoft Excel and Microsoft Word can automatically format the table for 
you. In Microsoft Access, you can format an entire datasheet. 

• For a table you can easily include in a PowerPoint poster, use Word.  

• For a table that includes complex graphics formatting (such as bulleted 
lists, custom tabs, numbering, hanging indents, individual cell formatting, 
and cells split diagonally) use Microsoft Word.  

• For a table that includes complex calculations, statistical analysis, or 
charts, use Microsoft 
Excel.  

To insert a table 

1. Copy the table from the program you used.  

2. In PowerPoint select Paste Special from the Edit menu, then select Picture 
(Enhanced Metafile). This imports the file in as a graphic file. It cannot be 
manipulated or changed because it is not linked to the original, but like 
the chart, a table inserted as a graphic file is much better for printing 
purposes.  



GRAPHICS, photos and figures 

Digital images are representations of pictures, drawings or graphics stored 
electronically as files in a variety of file types. Digital imaging refers to the 
process of acquiring, editing and presenting digital images. Among the most 
common file types that can be imported into PowerPoint are .wmf; .jpg; .bmp; 
.gif; and .tif. Each type has unique properties and advantages: 

• .wmf - this image format is scaleable within PowerPoint.  

• .jpg - an efficient and recommended format when saved at high image 
quality settings (low compression)  

• .tif - preserves maximum image quality, but files sizes are large  

• .gif - good for graphics but may not be rescaled; supports only minimum 
colors but allows for transparency  

Did you know: 
Images captured from web pages are of very low resolution and 
if enlarged will appear pixilated in your poster. These graphics 
are not recommended for poster presentations. 

A word about image resolution 

Remember that you are composing your poster at one half size the final size. 
Therefore our recommendation is that a photographic image should be at least 
150 pixels per inch at the final size desired in your poster. For instance, if you 
wish an image to be 5 inches wide by 4 inches deep in the final poster, the 
image resolution should be minimally 750 pixels wide x 600 pixels deep. 
Resolutions up to 300 pixels per inch will deliver better final image quality, but 
resolutions above 300 pixels per inch will not be noticeably better and will add 
considerably to the file size. In this application, the terms dpi (dot per inch) and 
ppi (pixels per inch) are synonymous. 

Inserting Images and other important image considerations 

• Insert graphics by selecting Picture from the Insert menu, .  

• Preserve the aspect ration of your images by using the Shift key when you 
resize graphics.  

• If you are scanning images for your poster be sure the images are either 
150 to 300 dpi. This will allow for resizing if it becomes necessary.  

• Avoid using pictures you find on the web. They are usually optimized at 
72 dpi and can look very grainy or "pixilated" if resized.  



• Do not use WordArt in your posters. It does not print well at larger sizes.  

• The tiff (*.tif) format is good for printing images. Jpeg (.jpg) is an 
excellent choice at the higher quality image settings. The jpeg format is a 
good compromise of image quality and efficient image size.  

• Make all significant changes to an image in an application other than 
PowerPoint. However, you can crop, resize, and perform some contrast 
and brightness adjustments within PowerPoint.   

 

• Slides, Photographs, and drawings that are not in a digital format can be 
scanned and saved as graphic files. We encourage you to save the file as 
a TIF or JPEG (at the maximum quality setting). It is important that you 
scan your images in at the size you need them to be printed out. If the 
image is going to be 8 inches by 10 inches, then you need to set the 
scanner for that image size at 250 dpi - 300 dpi (dots per inch). In this 
regard, dots per inch and pixels per inch are synonymous. Note that the 
larger the file, the longer it takes to print. Smaller files are also easier to 
manipulate and manage.  

AutoShapes 

PowerPoint comes with a set of ready-made shapes that you can use in your 
posters. The shapes can be resized, rotated, flipped, colored, and combined with 
other shapes to make more complex shapes. The AutoShapes Menu on the 
Drawing toolbar contains several categories of shapes, including lines, 
connectors, basic shapes, flowchart elements, stars and banners, and callouts. 
You can add text to AutoShapes by clicking in the shape and typing. Many have 
an adjustment handle (a yellow diamond) that you can use to change a special 
aspect of a shape. 

Position, align, and space text in an AutoShape 

When text is attached to an AutoShape, such as a callout or flowchart symbol, 
you can change the position of the text, change the shape of the object to fit the 
text, make the text wrap in the object, or change the amount of space between 
the text and the edge of the object. To attach your text to an object, click the 
object and type the text. Note: You can also use the same procedures to 
position, align, and space text that was added by using the Text Box tool on the 
Drawing toolbar. 



Add a line 

1. Click AutoShapes in the Drawing toolbar, point to Lines, and then click the 
line style you want.  

2. Drag to draw the line. To constrain the line to draw at 15-degree angles 
from its starting point, hold down SHIFT as you drag. To lengthen the line 
in opposite directions from the first end point, hold down CTRL as you 
drag.  

Change the color of a line or border 

1. Select the object you want to change.  

2. On the Drawing toolbar, click the arrow next to Line Color, or right click 
and select Format, Autoshapes.  

Change the style of a line or border 

1. Select the line or border you want to change.  

2. On the Drawing toolbar, click Line Style.  

3. Click the style you want or click More Lines and then click a style.  

Add or change a fill 

You can fill objects with solid or gradient (shaded) colors, a pattern, a texture, or 
a picture. Any time you fill an object, the new fill replaces the old one. If you 
change an object's fill, you can easily change it back to its default. 

 

LAYOUT CONSIDERATIONS 

Grouping 

The Draw menu has many options to help you 
work with your drawing objects. The first three, 
Group, Ungroup and Regroup, are for multiple 
objects. Use the shift key to pick up more than 
one object at a time. 
Order is a menu that can be pulled free. It allows 
you to choose within the layers of objects which 
object is in front of the others. 

Grid 

Select Grid from the drawing toolbar. PowerPoint 



has an invisible grid that objects snap to. This option window will allow you to 
adjust that spacing. The arrow keys on the keyboard and the Nudge option on 
this menu will move the object to the next grid location. However, you can 
always nudge your objects just a little bit by using Ctrl and the arrow keys on 
the keyboard. 

In addition, no matter where you place your objects you can always have them 
line up where you want them to or distribute an equal amount of space between 
them by using the Align or Distribute feature. If the Relative to Page button is 
pushed, you only need to have one object selected. The Edit Points option allows 
you to edit the wrap points around an object. Change AutoShape option allows 
you to change the selected object into any other shape. It will maintain its size, 
colors and position. If you draw a object and then change its options, you can 
then choose the Set AutoShape Default option such that every time you draw 
that shape again it will retain your customized colors and line styles. 

 

 


